Integrating Software Metrics with UML Class Diagrams

Metin Turan

Abstract—Software measurement tools have been used to support quality assurance through the development cycle with an increasing popularity recently. However, understanding the results of these tools still is a big problem. They generally present polymeric views which are too complex and hard to comment on.

In this study, a software tool was developed to present metrics in UML class diagrams. Colors of traffic lights are used to colorize the status of units in classes. Status is determined by techniques called limit and point approaches. Tool includes common structured and class based complexity metrics and only parses C# grammar presently.

Finally a survey is applied to computer engineering students taken software engineering course. The obtained feedback is affirmative and useful for further steps.

Index Terms—Software metrics, software quality, software tool, UML.

I. INTRODUCTION

Software tools facilitate to meet software quality targets. If software developers had a reliable tool, then they would determine the deviation and take care as soon as possible. Generally, early realization saves your money and time. But the most importantly, you have the chance to understand your product quality.

Software tools could be categorized by different ways. Most of them are used as development IDE. Some of them produce source code from your design. Few of them translate your existing code to a higher version or another programming language. Rest of them helps to estimate cost or schedule of a project. They all guide us make our work easily. But, if you want to measure software artifact quality, then you need software metric tools through the software cycle.

Software metrics research has been started at early of 1970’s. Computers had limited resources although the size of codes increased rapidly. Programmers tried to find an efficient way to executing bigger code on the same memory size. What could affect the size of an executable? Size and productivity metrics have been discovered. Then using the other physical characteristics of software, taking into consideration of the software modeling, lots of metrics have been emerged. Some of these metrics were painful to consider of the software modeling , lots of metrics have been discovered. Then using the size. What could affect the size of an executable?

Finally a survey is applied to computer engineering students taken software engineering course. The obtained feedback is affirmative and useful for further steps.

When big software projects have been emerged by 1990’s, software metrics have gained importance again. Object-oriented programming, aspect oriented programming and service-oriented programming models reveal the importance of software metrics. On the other hand, it has been a research area to adopt existing structured programming metrics to new programming models and finding new ones. However, the proposed software metrics up to date have been practically discovered and theoretically proof remains weak. Although there are information [11]-[13], graph [4]-[6], lattice [7], communication [8]-[10] and other [11]-[13] theoretic researches, this stands still a handicap for commonly usage of software metrics.

There are many metric tools available in the market (PMD with Eclipse) and most of them are available on the Internet (Squale, Sonar or Moose). They present metrics in polymeric views [14], [15]. The types of the metrics they support are differentiated [16]. Tools generally support a few programming languages, not all.

Software products generally suffer from complexity. This leads to failure of software product in a short-term life. Sometimes, software may need refactoring in the case of performance lack or requirement changes [17], [18].

A metric tool which shows the complex code segments of a project developed by using C# programming language on the UML class diagram has been developed. The research has been divided into two sub-projects (Fig. 1). First sub-project aim is to calculate and save metrics in an XML file. Second sub-project uses this XML file to represent selected metrics on an UML class diagram.

The parsers used in project described at Section II. Quality metrics used are explained at Section III. XML design strategy and UML presentation is given at Section IV and Section V respectively. Application user interface is picturized at Section VI. Survey result is given at Section VII. Finally, the conclusion and future works are discussed at Section IX and Section X respectively.

II. WORK

A. Parsers

Project has been developed for C# projects initially. Gold and CM parsers have been selected between lots of free parsers after a deeply research. Gold parser gives only tokens and types of these tokens for any programming language grammar. Gold parser has been used for calculating line counts, comment counts and other countable metrics of software for this reason. However, CS parser is a utility which parses the C# source code and creates a tree of the code nested within the other. CS Parser has been preferred for calculating object oriented metrics.

B. Metrics

Metrics are measure of some property of a piece of software or its specifications. Since quantitative methods

Manuscript received April 8, 2014; revised August 4, 2014.
Metin Turan is with the Yildiz Technical University, Beşiktaş, İstanbul, Turkey (e-mail: turanmetin@ gmail.com).

DOI: 10.7763/LNSE.2015.V3.194
have proved so powerful in the other sciences, computer science practitioners and theoreticians have worked hard to bring similar approaches to software development.

Software metrics provides a means of measuring software both under development and after a system is deployed. However, software is an abstract construct and measuring is really hard.

The approved software complexity metrics up to now have been generally related to the product metrics. The rest have been related to the other programming models like OOP (Object-Oriented Programming).

The metrics listed at Table I have been selected for the first version of the software from the recommended metric suits [19]-[21].

New metrics at Table II has been added to the project finally [22]-[25].

TABLE I: FIRST VERSION METRICS

<table>
<thead>
<tr>
<th>Metric</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RFC (Response for a class)</td>
<td></td>
</tr>
<tr>
<td>MPC (Message passing coupling)</td>
<td></td>
</tr>
<tr>
<td>Fan-In</td>
<td></td>
</tr>
<tr>
<td>Fan-Out</td>
<td></td>
</tr>
<tr>
<td>McCabe Cyclomatic Complexity</td>
<td></td>
</tr>
<tr>
<td>Halstead Metrics</td>
<td></td>
</tr>
<tr>
<td>Lines of Code</td>
<td></td>
</tr>
<tr>
<td>Comment Percentage</td>
<td></td>
</tr>
<tr>
<td>Total Function Call (Fan out)</td>
<td></td>
</tr>
</tbody>
</table>

TABLE II: FINAL VERSION ADDED METRICS

<table>
<thead>
<tr>
<th>Metric</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lack of Cohesion of Methods</td>
<td></td>
</tr>
<tr>
<td>Cohesion Ratio</td>
<td></td>
</tr>
<tr>
<td>R0,R1,R4 Coupling [16]</td>
<td></td>
</tr>
<tr>
<td>Depth of Inheritance Tree</td>
<td></td>
</tr>
<tr>
<td>Number of Children</td>
<td></td>
</tr>
<tr>
<td>Weighted Methods per Class</td>
<td></td>
</tr>
<tr>
<td>Average Class Complexity</td>
<td></td>
</tr>
<tr>
<td>Number of Methods per Class</td>
<td></td>
</tr>
<tr>
<td>Number of Attributes per Class</td>
<td></td>
</tr>
<tr>
<td>Information Flow Complexity</td>
<td></td>
</tr>
<tr>
<td>Class of Lines</td>
<td></td>
</tr>
</tbody>
</table>

C. XML Design

XML structure is designed to support data representation in UML class diagram. Tag names are selected fastidiously. Final XML structure is generic and free to extend.

```xml
    <?xml version="1.0" encoding="utf-8" ?>
    <exp>
        <Class>
            <Properties>
                <Name>mainFrm</Name>
                <Path>C1\Sources\Form1.cs</Path>
                <Scope>Public</Scope>
                <Inherits>Form</Inherits>
                <IsPartial>True</IsPartial>
                <IsStatic>False</IsStatic>
            </Properties>
            <Metrics>
                <RFC>0</RFC>
                <MPC>0</MPC>
                <FanInReferencedMethods />
                <MethodName />
                <Count />
                <FanOutReferencedMethods />
                <ClassName />
                <MethodName />
                <Count />
                <FanOutReferencedMethods />
                <DepthOfInheritanceTree>0</DepthOfInheritanceTree>
                <NumberOfChildren>0</NumberOfChildren>
                <WeightedMethodPerClass>0</WeightedMethodPerClass>
                <AverageClassComplexity>0</AverageClassComplexity>
                <InformationFlowComplexity>0</InformationFlowComplexity>
                <NumberOfMethodsPerClass>3</NumberOfMethodsPerClass>
                <NumberOfClass>3</Class>
                <Static>0</Static>
                <NumberOfMethodsPerClass>3</NumberOfMethodsPerClass>
                <NumberOfAttributesPerClass>6</NumberOfAttributesPerClass>
                <CohesionRatio>0</CohesionRatio>
                <LackOfCohesion>0</LackOfCohesion>
                <Coupling>0</Coupling>
                <ClassLineCount>20</ClassLineCount>
            </Metrics>
        </Class>
    </exp>
```

The Fig. 2 shows the class tag structure of an example XML data. Class is tagged with Class tag and includes properties, metrics and methods. Properties tag contains name, path, scope, inherited classes and C# specific information partial or static. Metrics tag includes class based metrics given at Section III.

The Fig. 3 shows the Method tag structure of an example XML data. A method is tagged with Method tag and includes properties and metrics. Properties tag includes name, scope, return type and parameters of the method. Each parameter is also defined in Parameters tag individually with parameter properties. Metrics for methods includes structure based
metrics like size, Cyclomatic Complexity and Halstead.

D. UML Presentation

The UML class diagram has ability to show the dependency and inheritance relations between the classes referred in the given sources. Referenced fan-in and fan-out metrics are also included in the UML diagram. The UML class diagram drawn in Fig. 4 is evaluation of an example class.

```xml
<exp>
  <class>
    <properties/>
    <methods/>
  </class>
  <properties/>
    <name>openToolStropMenuitem_Click</name>
    <Scope>Private</Scope>
    <ReturnType>void</ReturnType>
  </parameters>
  -<parameters>
    -<Parameter>
      <name>sender</name>
      <Type>Object</Type>
      <Parameter>
        <name>event</name>
        <Type>Unknown</Type>
      </parameters>
    </parameters>
  </properties>
  <methods/>
  -<Metric>
    <LineCount>4</LineCount>
    <CommentPercentage>0</CommentPercentage>
    <TotalFunctionCall>3</TotalFunctionCall>
    <Cyclomatic Complexity>3</Cyclomatic Complexity>
    <ForLoopCount>0</ForLoopCount>
    <IfElseLoopCount>0</IfElseLoopCount>
    <WhileLoopCount>0</WhileLoopCount>
    <IfStatementCount>1</IfStatementCount>
    <SwitchCaseCount>0</SwitchCaseCount>
    <HalsteadProgramLength>0</HalsteadProgramLength>
    <HalsteadProgramLevel>0</HalsteadProgramLevel>
    <HalsteadProgramLevelEquation>0</HalsteadProgramLevelEquation>
    <HalsteadIntelligentContent>0</HalsteadIntelligentContent>
    <HalsteadPotentialVolum>0</HalsteadPotentialVolum>
    <HalsteadEffectEquations>0</HalsteadEffectEquations>
    <HalsteadTimeEquations>0</HalsteadTimeEquations>
  </Metric>
</exp>
```

![Fig. 3. XML method design.](image)

<table>
<thead>
<tr>
<th>Question</th>
<th>Yes</th>
<th>No</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is the developed tool easy and comprehensible?</td>
<td>14</td>
<td>3</td>
<td>%82</td>
</tr>
<tr>
<td>Would the developed tool be useful in a software course?</td>
<td>12</td>
<td>5</td>
<td>%70</td>
</tr>
<tr>
<td>Is it useful to detect deficiency in a software system using class diagram integrated with software metrics?</td>
<td>11</td>
<td>6</td>
<td>%64</td>
</tr>
</tbody>
</table>

In the literature threshold values for software metrics has not been determined clearly yet. This leads to misunderstanding or misusage in the case of evaluation software metrics. The web site of NASA is a well-known resource to apply for that kind of reference [26]. But, only the threshold values for Line Count and Cyclomatic Complexity are defined to be 200 and 10 respectively. This is a big drawback for evaluation.

On this point we suggest a new approach and applied for evaluation. First of all, all software systems have different complexity (functional analysis supports that) due to the subject or application area. Moreover although the problem was same the analysis and design strategy would cause different complexity. As a result, each system is different theoretically and this leads to evaluate software systems independently. Each has own characteristics and deviations these must be evaluated separately. Deviations must be handled in the evaluated system comparing with other units not by another system or general values.

Based on the previous idea, software metrics are applied to the software units. The average metric value of all units is calculated to get a threshold value which shows above or under success. This is a point approach. On the other hand, the point may oscillate under or above by standard deviation. This is a limit approach. Former one is more restricted. In an Object-Oriented Software System, we suggest using point approach for class based metrics and limit approach for method based metrics.

Traffic lights are selected to colorize status of software units after measurement. Green, yellow and red colors show that metric value is very good, acceptable but need attention, and unacceptable respectively. Point approach contains only red and green values. However, limit approach has yellow values which show the values that are acceptable. For the current version, the metrics used for colorization are limited to some class based (RFC, MPC, Fan in Referenced Methods, Fan out Referenced Methods) and method based (Line Count, Comment Percentage, Total Function Call, Halstead Length,) metrics.

It should be realized that proposed technique is separated from the metric lens and other approaches which produces information from the UML diagrams [27]-[29].

E. Application

The captured application main screen (Fig. 5) points out that usage is simple. It is composed of three parts. The left side shows the previously created projects. The middle part shows the list of the class files included in the project. The right side shows the metrics exist in the project. The metrics are grouped meaningfully and user may select metrics checking a metric group or individually one by one. On the above of the middle part an operational menu resides which includes opening an existing project, creating new project and including a new class file into the project options.

Calculate Metrics button is used to calculate selected metrics on the source files. When metrics calculated they are stored at a local database table and an explorer window opens automatically to show the data in XML format. User can save results pressing Export to XML File button. User may calculate different metrics for each experiment and give them a meaningful file name to evaluate later.

Every project is stored at the file system with a special subfolder using the project name. All resources (project class
files and XML output) are saved there. When application starts then all previous projects are reloaded. User may select one of them or open another one. User can add new class files to the previous projects and recalculate metrics.

III. EVALUATION

The tool is experienced by seventeen students (they were registered to software engineering course). Students set free to select a couple of source code written by them in C#. They applied the tool and observed the UML diagram presented.

The following survey questions were asked and the answers were registered. The statistical results of survey are presented at Table III.

![Fig. 4. UML presentation.](image)

In this project a method for detecting defective units of a software product and presentation technique has been proposed and developed by a metric tool.

Polymetric views are graphical visualization of software enriched by metrics (system complexity, class blueprint). However, it is too complex and condensed representation to
understand even for an experienced software specialist. We suggested a simple UML presentation enriched with metrics and colorized defective units to be noticed easily. It is experienced by students and the results are acceptable.

It is realized that metrics chosen for a tool is important to describe and report software product. Metrics should be experienced by students and the results are acceptable. It is realized that metrics chosen for a tool is important to describe and report software product. Metrics should be experienced by students and the results are acceptable.

V. FURTHER WORK

This project handles only C# grammar presently. The well-known other language grammars (C typed languages Java and C++ especially) could be integrated by the time. The metrics selected in this project calculates the complexity of the software units. Project needs to be extended include some templates, such as quality, complexity and maintenance.

UML representation should be extended to cover more graphical abilities.

REFERENCES


Metin Turan was born in Istanbul, in 1967. He received B.Sc and M.Sc degrees from the Department of Computer Sciences of Hacettepe University in Ankara in 1990 and 1993 respectively. He is currently a doctorate student at the Department of Computer Engineering of Yildiz Technical University. He worked as a system analyst, software specialist, project manager and software manager positions more than 15 years in industry. His last job was at the Department of Computer Engineering of Istanbul Kültür University. He worked as a lecturer and taught Int. to programming, object-oriented programming, data structures, visual programming, web programming, software engineering and programming languages courses more than 8 years. His major research areas are software metrics, software engineering, document summarization, text mining and algorithms. He is currently working as a consultant for software houses.

He is a member of IRED and IACSIT societies. He has published 8 technical papers in national and international journals.